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Un par de notas

Aquí están los textos completos de mi Cómic de Introducción a Arduino. Cada página está descrita en términos de viñetas en esa página. Para cada viñeta hay una descripción del dibujo o contenido gráfico, cada uno de los textos en los bocadillos, texto en los Viñetas de texto y etiquetas de texto que hay en el dibujo. He indicado que texto está en negrita en los bocadillos y en las Viñetas.

Probablemente la mejor forma de probar el posicionamiento y los estilos sea comparando con el PDF original.

Fuentes:

Para la mayoría del texto en los bocadillos y los Viñetas he usado la fuente LetterO Matic! de 9 puntos. He usado LetterO Matic! De 10 puntos en negrita para los textos que he querido enfatizar en los Viñetas, 9 puntos en palabras de los bocadillos. La mayor parte del texto está en negro (#000000), el texto resaltado a veces es rojo (#FF0000) o gris (#666666).

He incluido la información del tamaño y color de la fuente en los Viñetas si es diferente del normal de 9 puntos.

Nota del traductor: Para el código he cambiado a la fuente Andale Mono de 11 puntos con los mismos colores con los que aparece en el Arduino IDE (naranja #CC6600 y azul #006699).

En la última página, la cual tiene mucho texto, las sub-cabeceras están en 11 o en 9 puntos, los enlaces están en 8 puntos. En el último Viñeta mis datos están a 10 puntos, los agradecimientos en 7 puntos y la licencia Creative Commons en 6 puntos.

Nota del traductor:

Como en el cómic todos los textos están en mayúsculas a partir de aquí lo escribo todo en mayúsculas para que sea más fácil copiar y pegar al editar el PDF.

Los voluntarios que traduzcáis al resto de lenguas no hace falta que lo traduzcáis todo, solo lo marcado como bocadillo, caja de texto, etiquetas y comentarios del código. Lo mejor es que a la vez que traduzcáis vayáis mirando el PDF original para ir viendo como van los textos.

La fuente LetterOMatic no tiene acentos ni ñ así que acentos no he puesto con este tipo de letra (erróneamente creía que en en castellano cuando se escribe con mayúsculas los acentos no son necesarios pero resulta que si, lo dejo para una segunda revisión) y el rabito de la ñ lo he pintado a mano.

PÁGINA 1: Introducción y Definición de términos

Viñeta 1:

Dibujo:

Arduino! Sobre un dibujo semi-transparente de una Arduino Uno.  Por Jody Culkin 

Viñeta 2

Dibujo: Cabeza y hombros mirando hacia la izquierda

Bocadillo: ¿Que es un Arduino?

(Caja de texto) Es una plataforma de prototipado electrónica de diseño abierto. ¿Que significa esto?

Viñeta 3

Dibujo: Definiciones de abierto, electrónica, prototipado, plataforma sobre fondo azul con los términos a la izquierda a 14 pt en negro, a la derecha formas blancas con las definiciones en gris a 9pt.

(Texto)

Abierto- “Recursos que pueden ser usados, redistribuidos o modificados de forma gratuita. A menudo software o hardware.”

Electrónica- ”Tecnología que hace uso del movimiento controlado de electrones a través de diferentes medios.”

Prototipo- “Una forma original que puede servir como base o standar para otros objetos.”

Plataforma- “Arquitectura de hardware con una base de software que le permite ejecutar programas.”

PÁGINA 2: Introducción a la plataforma y a los microcontroladores

Viñeta 4 

Dibujo: Un Arduino conectado a una placa de prototipado con una fotocélula y un  LED con un personaje mirando y señalando.

Etiquetas:

Microchip 

Fotocélula

Placa de prototipado

LED 

(Caja de texto): Un Arduino contiene un microchip, que es un ordenador muy pequeño que podemos programar. Se le pueden conectar sensores para que pueda medir condiciones (como cuanta luz hay en la habitación). Puede controlar otros objetos para que reaccionen a esas condiciones (si la habitación está a oscuras enciende el LED).

Viñeta 5

Dibujo: 2 interruptores 

Etiquetas:

ENCENDIDO

APAGADO

(Caja de texto) O puede reaccionar cuando un interruptor es accionado.

Viñeta 6

Dibujo:  dedo señalando un ratón y un monitor.

Bocadillo: Un ratón es un dispositivo de entrada común para un ordenador, un monitor es un dispositivo de salida.

(Caja de texto) Los Microcontroladores usan entradas y salidas como cualquier ordenador. Las entradas leen información del usuario o el entorno mientras que las salidas hacen algo con la información que ha sido leída.

PÁGINA 3: Entradas y salidas, analógico y digital

Viñeta 7

Dibujo:  Pulsador y sensor de presión

Etiquetas:


Pulsador

Sensor de presión

(Caja de texto) Una entrada para Arduino puede ser un pulsador o un sensor.

Viñeta 8

Dibujo: motor DC, portátil 

Etiquetas:


Motor DC

(Caja de texto) Cualquier objeto que queramos encender, apagar y controlar puede ser una salida. Puede ser un motor o incluso un ordenador.

Viñeta 9

Dibujo: Cabeza y hombros mirando a la derecha

Bocadillo: ¿Cual es la diferencia entre las entradas o salidas digitales o analógicas?

(Caja de texto) Las entrada y salidas pueden ser digitales o analógicas. En las digitales la información es binaria- sólo puede ser verdadero o falso. La información analógica es continua, puede manejar un amplio rango de valores.

Viñeta 10

Dibujo: Figura con las manos en la cintura

Bocadillos: 

Izquierda: La información digital es discreta y finita. Toda la información se describe con dos estados, 1 o 0, encendido o apagado. 

Derecha: Información analógica se caracteriza por su naturaleza continua. Puede ser un número infinito de valores posibles.

(Caja de texto) Un pulsador es una entrada digital, un sensor es una entrada analógica. El rango de un sensor está limitado por su conversión a dato digital.

PÁGINA 4: Repaso de electricidad, términos y conceptos

Viñeta 11

Dibujo: Figura de perfil, manos hacia arriba 

Bocadillo: ¿Voltaje? ¿Intensidad? ¿Resistencia? ¿Ley de Ohm?

(Caja de texto): Antes de conectar el Arduino, debemos repasar unos pocos términos y principios sobre como la electricidad (y la electrónica) funciona. 

Viñeta 12 (definiciones en las cajas blancas)

Voltaje (V) es la medida del potencial eléctrico en un circuito. Se mide en voltios.

Viñeta 13

Intensidad (I) es la cantidad de flujo que atraviesa un material conductor. Se mide en amperios o amps.

Viñeta 14

Resistencia (R) es la oposición del material al flujo de la corriente eléctrica. Se mide en ohmios.

(Caja de texto por debajo de las anteriores) La electricidad es el flujo de la energía eléctrica a través de un material conductor.

Viñeta 15

Dibujo: depósito de agua con mangueras a través de las que pasa agua conectada a una válvula que limita el paso de agua.

(Texto en las cajas blancas)

(Cerca del depósito) La velocidad de flujo está determinada por el voltaje

(Cerca de la válvula) La Resistencia aumenta o disminuye el flujo

(Cerca de la manguera) La cantidad de agua que se mueve por la manguera es la intensidad

(Caja de texto): La analogía del agua se usa normalmente para explicar estos términos. Aquí hay un modelo.

PÁGINA 5: Ley de Ohm, que es un circuito, esquema

Viñeta 16 

Dibujo: (Ley de Ohm en una forma blanca. Línea superior en rojo a 16 pt, leyes en negro a 9 pt, o gris a  7 pt) 

Ley de Ohm

Intensidad = Voltaje/Resistencia

(I= V/R)

or

Resistencia = Voltaje/Intensidad

(R = V/I)

or

Voltaje = Resistencia * Intensidad

(V = R*I)

(Caja de texto): Hay una relación entre  voltaje, intensidad y resistencia descubierta por Georg Ohm, un físico Alemán.

Viñeta 17

Dibujo: Depósito con manguera y válvula limitando el paso del agua

(Caja de texto): Por ejemplo, incrementando la resistencia se reduce el flujo.

Viñeta 18

Dibujo: Depósito más grande, más flujo por la manguera

(Caja de texto): O incrementando el potencial, más flujo.

Viñeta 19

Dibujo: batería conectada con dos cables a un pulsador y a una bombilla

(Caja de texto): Ahora miremos un circuito simple. Cada circuito es un círculo cerrado que tiene una fuente de energía (batería) y una carga (bombilla). La carga transforma la energía eléctrica de la batería y la utiliza. Este también tiene un pulsador.

Viñeta 20

Dibujo: Esquema de un circuito sencillo

Etiquetas: (fuente de texto-Geneva)


Bombilla

Pulsador

Fuente de corriente continua


(Caja de texto): Este es el esquema del mismo circuito (representa el circuito utilizando símbolos para los componentes electrónicos). Cuando el pulsador se cierra la corriente fluye desde la fuente de energía y enciende la bombilla.

PÁGINA 6 AC, DC, vuelta a Arduino, USB, software

Viñeta 21

Dibujo: Esquema de Corriente Continua y Corriente Alterna.

Etiquetas:

Corriente Continua (DC) 

Corriente Alterna (AC)

(Caja de texto): Hay dos tipos de circuitos, los de corriente continua y los de corriente alterna. En los circuitos DC la corriente siempre fluye en una dirección, en los de AC la corriente fluye en direcciones opuestas en ciclos regulares. Nosotros solo hablaremos de circuitos DC.

Viñeta 22

Dibujo: vista de un Arduino, figura de perfil con mano apoyada en la cara

Bocadillo: Ahora que hemos repasado algunos conceptos básicos sobre la electricidad vamos a volver a Arduino.

(Caja de texto): La Arduino necesita energía para funcionar. Necesitamos conectarla a un ordenador para programarla.

Viñeta 23

Dibujo: Arduino, portátil, cable USB conectándolo a ambos

(Caja de texto): Conectar la Arduino a un ordenador con un cable USB le proporciona la energía que necesita y nos permite programarla.

Viñeta 24

Dibujo: vista cerrada de la interfaz de la web de Arduino. Forma blanca con el texto:

Etiquetas:

Descargadlo aquí (rojo 18 pt)

 http://www.arduino.cc/es/Main/Software (negro 10 pt)(link activo)

(Caja de texto): Tienes que descargar e instalar este software para programar una Arduino, está disponible en la URL de arriba de forma totalmente libre. El software de Arduino funciona en Mac OS X,  Windows y Linux.

PÁGINA 7: Descarga el software y conecta la placa (las páginas 7 y 8 contienen capturas de pantalla del IDE cambiar por el IDE 1.0)

Viñeta 25

Dibujo: Texto sobre una forma blanca (las URLS están linkadas) (URLS en rojo a 10 pt, otros textos en negro a 9 pt)

Para instrucciones sobre como hacer la instalación

del software de Arduino en un Mac:

http://www.arduino.cc/es/Guide/MacOSX 

Instrucciones para la instalación en

Windows:

http://www.arduino.cc/es/Guide/Windows

Intrucciones para la instalación en 

Linux:

http://www.arduino.cc/playground/Learning/Linux

(Caja de texto): Ve a las anteriores URLs de arriba para obtener detalladas instrucciones sobre la instalación en cada una de esas plataformas.

Viñeta 26:

Dibujo: Detalle de Arduino con el led pwr encendido.

(Caja de texto): Cuando tengas instalado el software, conecta la Arduino. Un LED marcado como ON debería encenderse en la placa.

Viñeta 27:

Dibujo: Captura de pantalla de los menús del Arduino IDE para seleccionar una placa 

(Caja de texto): Lanzamos el software de Arduino. En el menú tools, selecciona la placa que estás utilizando (Tools > Board). Por ejemplo, Arduino Uno.

Viñeta 28:

Dibujo: Captura de pantalla de los menús del Arduino IDE para seleccionar el puerto serie 

(Caja de texto): A continuación selecciona el puerto serie. (Tools > Serial Port) En un Mac debe ser algo parecido a /dev/tty.usbmodem. En una máquina windows será COM3 o algo parecido.

PÁGINA 8: IDE, el primer script

Viñeta 29:

Dibujo: Figura hablando y mirando a la izquierda. 

(Bocadillo): ¿Que es un Entorno de Desarrollo Integrado (IDE)?

(Caja de texto): Cuando descargas el software de Arduino descargas un IDE. Este combina un editor de texto con un compilador y otras funciones para ayudar a los programadores a escribir programas.

Viñeta 30:

Dibujo: Captura de pantalla de los menús seleccionando el sketch Blink

(Caja de texto): El Arduino IDE te permite escribir sketches o programas y subirlos a la placa Arduino. Abre el ejemplo Blink en el menu file. File > Examples > 1.Basics > Blink.

Viñeta 31:

Dibujo: Captura de pantalla de la interfaz del Arduino IDE mostrando los botones y parte de un sketch. Flecha apuntando al botón de subida (cambiar por 1.0)

Etiquetas:


Botón subir

(Caja de texto): Para subir un sketch a la placa Arduino pinchamos en el botón de subir en la tira de botones en la parte superior de la ventana. Aparecerán mensajes en la parte inferior de la ventana y finalmente Done Uploading.

Viñeta 32:

Dibujo: Vista de detalle del Arduino con el LED 13 encendido.

(Caja de texto): El LED del pin 13 en la Arduino comienza a parpadear.

PÁGINA 9: escribiendo programas: setup y loop- Breve descripción del lenguaje

Viñeta 33:

Dibujo: script Blink en una caja blanca. No traducir los comentarios del código.

void setup() {                

  // initialize the digital pin as an output.

  // Pin 13 has LED connected on most Arduino boards:

  pinMode(13, OUTPUT);     

}

void loop() {

  digitalWrite(13, HIGH);   // set the LED on

  delay(1000);              // wait for a second

  digitalWrite(13, LOW);    // set the LED off

  delay(1000);              // wait for a second

}

(Caja de texto): Un sketch, como un programa escrito en cualquier lenguaje, es un conjunto de instrucciones para el ordenador. Si miramos con detenimiento el sketch Blink veremos que tiene 2 partes principales, el setup y el loop.

Viñeta 34:

Dibujo: dedos señalando las definiciones de setup y loop en cajas blancas. 

Texto (setup y loop en color rojo, definición en negro, todo a 10 pt.)

Setup: se ejecuta una vez cuando el programa arranca

Loop: se repite una y otra vez

(Caja de texto): Estos bloques de código se llaman funciones y cada sketch debe tenerlos. Todo su contenido está encerrado entre llaves { }.

Viñeta 35:

Dibujo: Figura de espaldas leyendo la referencia de Arduino en un portátil. URL (linkada) en la caja blanca 

Texto (rojo a 12 pt)

http://arduino.cc/es/Reference/HomePage 

(Caja de texto): Mira la página web de Arduino para consultar la guía de referencia y otros recursos para aprender el lenguaje. 

Viñeta 36:

Dibujo: Detalle del script blink con explicaciones linea por linea. Comentarios en rojo en LetterOMatic

Texto (traducir comentarios)

void setup() {              //declara un bloque de código   

  pinMode(13, OUTPUT); 
//pone el pin 13 como salida

}
//fin del bloque de código

void loop() {

//declara un bloque de código   

  digitalWrite(13, HIGH);
 //pone el pin 13 en alto

  delay(1000); 

//pausa de 1 segundo    

  digitalWrite(13, LOW);  
//pone el pin 13 en bajo

  delay(1000); 

//pausa de 1 segundo 

}
//fin del bloque de código

(Caja de texto): Ahora vamos a ver un programa sencillo línea por línea y vamos a ver que hace cada una.

PÁGINA 10: Utilizando un placa de prototipado, LED digital output

Viñeta 37:

Dibujo: Mano sosteniendo una placa de prototipado

(Caja de texto): ¿Como podemos controlar los objetos que no están en la placa Arduino? Conectando la Arduino a una placa de prototipado sin soldaduras.   Esta nos permite montar y probar circuitos rápidamente.

Viñeta 38: 

Dibujo: Detalle de una placa de prototipado- texto en cajas blancas con flechas rojas: (tipografía roja a 10 pt negrita)

Etiquetas: 

Agujeros conectados horizontalmente

Agujeros conectados verticalmente

(Caja de texto): Esta placa de prototipado tiene 2 filas de agujeros en los bordes derecho e izquierdo y 5 filas de agujeros a cada lado de la separación central. Las filas laterales están conectadas verticalmente, cada una de las filas de 5 agujeros están conectadas horizontalmente.

Viñeta 39:

Dibujo: Positivo y negativo conectados de Arduino a la placa de prototipado  y atravesando al otro lado para tener alimentación en ambos lados

(Caja de texto): Conectaremos positivo y negativo desde Arduino a las tiras verticales usando cables. Los componentes se pueden encajar desde los agujeros del centro a positivo o negativo según se necesite.

Viñeta 40:

Dibujo: LED.  El texto define el ánodo y el cátodo 

Etiquetas:

Ánodo (se conecta a positivo)

Cátodo (se conecta a negativo)

(Caja de texto): Cuando la corriente fluye a través de un LED (Diodo Emisor de Luz) en el sentido correcto se enciende. Conectaremos un LED a la placa de prototipado, luego al Arduino y lo controlaremos con código.

PÁGINA 11: Salida digital 

Viñeta 41:

Dibujo: Breadboard conectada a Arduino con un LED pinchado

(Caja de texto): El ánodo está conectado al pin 2 de Arduino a través de una resistencia de 220 Ohm. El cátodo está conectado a negativo. Los pines del 2 al 13 pueden ser configurados como entradas o salidas. Pincha en el botón new para abrir un nuevo sketch.

Viñeta 42:

Dibujo: Script en un cuadrado blanco

void setup() {                

  pinMode(2, OUTPUT);     

}

void loop() {

  digitalWrite(2, HIGH);  

  delay(500);             

  digitalWrite(2, LOW);   

  delay(500);             

}

(Caja de texto): En el setup ponemos el pin 2 como salida. En el loop primero ponemos el pin 2 en estado alto para que el led se encienda. El Delay hace una pausa de 500 milisegundos, o medio segundo. Después se pone el pin 2 en estado bajo y el led se apaga. Hacemos otra pausa de medio segundo.

Viñeta 43: 

Dibujo: botones del Arduino IDE (cambiar por el 1.0). Etiquetas de texto con flechas rojas ( color rojo a 10 pt negrita)

Etiquetas:

Botón verificar

Botón subir

(Caja de texto): Clicar en verificar para comprobar el código. Si no hay errores clicar en subir para pasar el programa a la Arduino.

Viñeta 44:

Dibujo: Viñeta dividida en 2, LED encendido, LED apagado

(Caja de texto): El LED brilla durante medio segundo, luego se apaga otro medio segundo y se repite una y otra vez.

PÁGINA 12: entrada Digital: montando un pulsador para encender y apagar un LED

Viñeta 45:

Dibujo: mano sujetando un pulsador

(Caja de texto): Ahora añadiremos un pulsador, una entrada digital, para encender y apagar el LED. 

Viñeta 46:

Dibujo: Detalle del pulsador conectado a la placa con el LED y resistencias

(Caja de texto): Conectar un cable del pulsador al pin 4 de Arduino, con una resistencia de 10k conectada a negativo y al mismo cable. Conectar el otro cable a positivo. Dejamos el LED conectado como estaba.

Viñeta 47:

 Dibujo: código para el sketch del pulsador en caja blanca

void setup() {                

  pinMode(2, OUTPUT); 

  pinMode(4, INPUT); 

}

void loop() {

  if(digitalRead(4)){

    digitalWrite(2, HIGH);  

  }else{            

  digitalWrite(2, LOW);   

  }

}

(Caja de texto): Ahora escribimos el código. En el setup declaramos el pin 2 como salida y el pin 4 como entrada. En el loop usamos una condición if, si lee el pin 4 como alto pone el LED en alto, de la misma forma lo lee como bajo el  LED se apagará.

Viñeta 48: 

Dibujo: Viñeta partida, dedo accionando el pulsador con el LED brillando, dedo levantado y LED apagado

(Caja de texto) El LED se enciende cuando el pulsador se acciona.

PÁGINA 13: Entrada analógica. Potenciómetro

Viñeta 49:

Dibujo: Figura de frente sobre un potenciómetro gigante.

Bocadillo: Ub potenciómetro es una resistencia variable. La resistencia cambia según se gira subiendo o bajando dependiendo de en que sentido lo giramos.

(Caja de texto): Ahora vamos a utilizar una entrada analógica. Usaremos un potenciómetro. 

Viñeta 50:

Dibujo: Breadboard con potenciómetro conectado a Arduino 

(Caja de texto): Conecta el pin central del potenciómetro al pin analógico A0. Conecta un extremo del potenciómetro a positivo y el otro a negativo.

Viñeta 51:

Dibujo: código para lectura analógica con salida serie en caja blanca

void setup() {                

  Serial.begin(9600); 

}

void loop() {

  Serial.println(analogRead(A0));  

}

(Caja de texto): Primero veremos el rango de valores que tomamos girando el potenciómetro utilizando el monitor serie.  En nuestro código inicializamos el objeto serial en el setup, estableciendo la velocidad a 9600 baudios. En el loop leemos el valor del pin analógico A0 y lo escribimos en el objeto serial utilizando la función printLn.

Viñeta 52:

Dibujo: Ventana del monitor serie en la interfaz del Arduino IDE mostrando valores. Flechas apuntando al botón del monitor serie. 

Etiquetas:

Click para abrir el monitor serie

(Caja de texto): Después de que hayas subido el sketch a Arduino, haz click en el botón del monitor serie para ver los valores tal como giras el potenciómetro. Una ventana se abrirá y verás aparecer valores entre 0 y 1023 cuando el potenciómetro es girado.

PÁGINA 14: Salida analógica

Viñeta 53: 

Dibujo: breadboard con potenciómetro conectado a Arduino, LED y resistencias

(Caja de texto): Vamos a utilizar los valores cambiantes que recibimos del potenciómetro para controlar un LED. Conecta el ánodo a través de una resistencia al pin 3 y el cátodo a negativo.

Viñeta 54:

Dibujo: Diagrama del ciclo de trabajo de un pulso con modulación de  profundidad en una caja blanca.

Etiquetas(respetar minúsculas):

0% Ciclo de trabajo - analogWrite(0)

50% Ciclo de trabajo - analogWrite(127)

100% Ciclo de trabajo - analogWrite(255)

(Caja de texto): Vamos a utilizar el Pulso con Modulación de Profundidad  (PWM). Este es un método para simular un valor analógico manipulando el voltaje, activándolo o desactivándolo a intervalos diferentes, o ciclos de trabajo. Puedes utilizar el PWM en los pines 3, 5, 6, 9, 10 y 11.


Viñeta 55:

Dibujo: código para una lectura analógica en una caja blanca

int sensorValue = 0;

void setup() {                

  pinMode(3,OUTPUT); 

}

void loop() {

  sensorValue = analogRead(A0);

  analogWrite(3, sensorValue/4); 

}

(Caja de texto): Primero creamos una variable para guardar en ella el valor del potenciómetro. En el setup establecemos el pin 3 como salida. En el loop guardamos el valor que hemos leído del pin a0 en nuestra variable. Luego escribimos el valor en el pin 3, nuestro pin para el LED. Debemos dividir el valor de la variable por 4, por que manejamos valores entre 0 y 255, o un byte.


Viñeta 56:

Dibujo: A la izquierda, viñetas superpuestas - superior: un LED con brillo reducido. Inferior: un LED brillando al máximo. A la derecha: manos girando un potenciómetro.

(Caja de texto): El brillo del LED cambia, variando de completamente apagado a muy brillante según giramos el potenciómetro.














PÁGINA 15: Links y creditos

Viñeta 57:

Dibujo: Figura en pie sobre el nombre y detalle de una placa Arduino

Bocadillo: Ya está! ESTA ES UNA MUY BREVE INTRODUCCION. EN LAS PRÓXIMAS Viñetas ENCONTRAREIS links Y OTROS RECURSOS PARA SEGUIR APRENDIENDO. PROVÁDLOS TODOS Y ENCONTRAREIS MUCHOS MÁS.

Viñeta 58:

Dibujo: textO DENTRO DE UNA CAJA BLANCA (TODAS LAS URLs SON linkS)

Links


    Software



dESCARGA 

   
     http://www.arduino.cc/eS/Main/Software 

REFERENCIAS DEL LEnguaJe 

   
     http://arduino.cc/eS/Reference/HomePAGE

    DONDE COMPRAR

ARDUINO STORE

      http://store.arduino.cc/ww/

ARDUMANIA.ES

      http://WWW.ARDUMANIA.ES/ARDUTIENDA

Viñeta 59: 

Dibujo: texto DENTRO DE una CAJA BLANCA (TODAS LAS URLs SON linkS)

tutoriales

tutoriales en Arduino .cc

   
    http://www.arduino.cc/eS/Tutorial/HomePAGE

tutoriales en Ardumania.es

   
    http://www.ardumania.es  seccion aprende

ELECTRONICA



 txapuzas.blogspot



    http://txapuzas.blogspot.com/

PDFS EN CASTELLANO

 

 arduino.cc/playground/Es



    http://arduino.cc/playground/Es/Manuales



ARDUMANIA.ES



    http://www.ardumania.es/descargas/

Viñeta 60:

Dibujo: texto DENTRO DE UNA FORMA BLANCA. LOGO DE LA  LICENCIA Creative Commons EN LA ESQUINA INFERIOR DERECHA.

TEXTOS Y DIBUJOS POR  Jody Culkin PARA VER MAS  jodyculkin.com

[pon aquí tus datos para pasar a la posteridad]

TRADUCCIÓN AL ESPAÑOL POR JOSE MANUEL ESCUDER (ARDUMANIA.ES)
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IntroducCion A Arduino POR Jody Culkin ESTA BAJO  LICENCIA Creative Commons 
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